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Rho P10 200/250 1  About this document 

 

1 About this document 
 Make sure that this document is accessible at all times. 
 Insert all supplements received from Durst Phototechnik AG into this document. 
 Read and comply with this document and all other documents in the service 

documentation. 
 

1.1 Purpose and target group 
This document is part of the service documentation and contains information about how to 
replace the print head modules. 
This information applies to printers of the Rho P10 200/250 range of Durst Phototechnik AG 
and should be referred to by the following personnel:  
 Durst service engineers (service engineer Durst group) 
 General service technicians (service technician distributor) 
 Trained customer’s technicians (in-house technician) 
 

1.2 Revisions 
Edition of the document What is new? 

20.02.2014 First edition 

03.03.2014 Preparing the old print head for the dispatch modified 

17.03.2014 New illustration for slot arrangement, encoder offset 
adjustment and drop fly time compensation 

21.08.2014 Camera unit Nikon (LH2099450) added 

28.10.2014 Detailed description about Nikon camera system added 

04.11.2014 Requirement of LAN to USB dongle device driver for Nikon 
camera system added. 

26.11.2014 Nikon camera system: connection and settings modified, 
troubleshooting added 

05.03.2015 Preparing the print head for dispatch modified 

Tab. 1: Revision index 

 

1.3 Symbols and markers 
Symbol Meaning 
  Pre-requirement for an action 
  Request for a single-step action 

1.  Step within a request for a multi-step action 

  Result of an action sequence 
 

 

 

 

Note for easier or safer work 
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1  About this document Rho P10 200/250 

 

Symbol Meaning 

 Cross-reference 

 DANGER! Immediately dangerous situation, where disregard of safety 
measures will lead to death or serious injury. 

 WARNING! Potentially dangerous situation, where disregard of safety 
measures may lead to death or serious injury. 

 CAUTION! Potentially dangerous situation, where disregard of safety 
measures may lead to minor injury. 

NOTE! Potentially dangerous situation, where disregard of safety 
measures may lead to damage to property. 

Tab. 2: Symbols and markers 

1.3.1 Structure of warnings 
Warnings are structured as follows (shown here as an example: the warning level 
“WARNING”): 
 

 WARNING! Type and source of the hazard 
Consequences of the hazard. 
 Measures for avoiding the hazard. 

 
 Read the warning and comply with it. 
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Rho P10 200/250 2  Materials and tools required 

 

2 Materials and tools required 
Designation Specification Order number 

Plug for ink tubes (print head side) FTLLP-6 black 1472683 

Cap for valve block MTLLP-6 black 1472676 

   

Head locking wrench for print head 
module 

Hexagon key L-wrench, 
3.0 mm 

LD2099801 

Head adjustment wrench for print 
head module 

Ball point, Tx10 LH2099800 

Camera unit V1 (Canon)  LH2099300 
 

Camera unit V2 (Nikon)  LH2099450 

Tab. 3: Materials and tools required 

 

 

The camera units Canon and Nikon can both be used for the automatic slot offset 
alignment. 
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3  Description of the print head module Rho P10 200/250 

 

3 Description of the print head module 
3.1 Position of the fixing screws and adjustment screws 

 

 

Fig. 1: Position of the fixing screws and adjustment screws 

1 Adjustment screw (X rotation) 
2 Adjustment screw (Y direction) 
3 Fixing screw 
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Rho P10 200/250 3  Description of the print head module 

 

3.2 Slot arrangement 
 

 

Fig. 2: Slot geometry 

 

3.3 Arrangement of the print heads 

 

Depending on the exact configuration of the printer, the arrangement of the print heads can 
be seen on the circuit diagram ( circuit diagram). 

 

  

Fig. 3: Arrangement the print heads for CMYKcmBO (example) 
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4  Replacing the print head module Rho P10 200/250 

 

4 Replacing the print head module 

 WARNING! Contact with inks! 
Risk to health if inks are allowed to come into contact with skin or eyes or if inks are 

breathed in. 
 Wear safety gloves. 
 Wear safety glasses. 
 Avoid allowing the ink to come into contact with skin or eyes. 

 

NOTE! Improper installation and deinstallation! 
Damage to the print head modules. 
 Do not touch the circuit board contacts. 
 Do not touch the nozzle plate. 
 Do not kink the ink tubes. 

 

4.1 Before replacing a print head module 

 

The droplet size generated by print head modules for standard colors (CMYKcmBO) differs 
from the size generated by print head modules for spot colors: 
 CMYKcmBO: 10 pl 
 Spot colors: 30 pl 
For this reason, the order numbers for print head modules for standard colors differ from the 
order numbers for print head modules for spot colors. 
 When ordering a print head module, check that the order number is correct. 
 Before replacing a print head module, check that the correct print head module has 

been supplied: 
– Serial number 913xxxx: Print head module with 10 pl 
– Serial number 916xxxx or 910xxxx: Print head module with 30 pl 

 

 

Before replacing a print head module, print a test pattern. This provides documentation of 
the condition of the nozzles. 
 Printing a density compensation test pattern ( Chapter 6.2, p. 31). 
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Rho P10 200/250 4  Replacing the print head module 

 

4.2 Disassembling the old print head module 
 Have the necessary tools to hand: 

– Covers: 
Plugs for ink tubes 
Caps for valve block 

– Head locking wrench for print head module 
 

4.2.1 Preparing for disassembly of the print head module 
 Ink heating must be switched on. 
 The print heads must be up to working temperature. 
 The print heads must be filled with ink. 
 

1. Select the Ink Heating tab. 
2. Check the temperature of the print heads. 

The print heads must have reached working temperature. 

 

4.2.2 Disassembling the print head module 
 

 

As soon as there is no vacuum in the meniscus tube, ink will flow out of the print heads. 
 Finally, pull off the meniscus tube. 

 

1. At the parking position, line the purge tray with paper. 
2. Detach all cables from the print head module. 
3. Undo the fixing screws 
4. Carefully pull the ink tubes off the printer valve block. 
5. Fit plugs or caps to seal off the ink tubes at the print head end and printer end. 
 

 

When pulling off the meniscus tube, make sure that the vacuum is maintained until the seal 
has been made, for instance by pressing the meniscus tube. 

 

6. Pull the meniscus tube off the printer and seal the print head end. 

 

3. Select the LOIS tab. 
4. Check the ink level in the print heads. 
The print heads must be filled with ink. 

 

5. Select the Pumps / Valves tab. 
6. Switch off the Ink Level Control. 

 

7. Select the Printer tab. 
8. Switch off the Ink Heating. 
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4  Replacing the print head module Rho P10 200/250 

 

7. Seal the meniscus tube at the printer end. 
8. Carefully lift the print head module off the print carriage. 
9. Carefully pull the legible stickers off the ink tubes and off the print head module, and affix 

them to the new print head module. 
10. Use the old print head module as reference to cut the ink lines of the new print head. 
 

4.3 Preparing the old print head for the dispatch 

 

Print head modules must be empty when sent to Durst Service. 

 

4.3.1 Draining the old print head 
 Have the necessary materials to hand: 

– One way syringe 
– Filter PTFE 50mm 0,45µm 

 

 

1. Take a new clean syringe.  
2. Connect the syringe with the meniscus 

filter. 
3. Open one side of the meniscus tube. 
4. Connect the meniscus filter with the 

meniscus tube. 
5. Push with the syringe air through the 

meniscus line until the print head is 
empty. 

6. Remove the meniscus filter form the 
meniscus line. 

7. Seal the meniscus tube. 
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Rho P10 200/250 4  Replacing the print head module 

 

4.3.2 Capping the old print head for dispatch 
 Have the necessary materials to hand: 

– Capping plate (included in the scope of supply of a new or refurbished print head 
module) 

 

5. Fill in the Print Head Change Form. 
6. Send the old print head to Durst Service, enclosing the following data in a package 

protected against ink: 
– Test pattern printed using the old print head module 
– Test pattern printed using the new print head module 
– Print Head Change Form 

 

 

The Print Head Change Form is supplied with the new print head module. 

 

 

1. Attach the capping plate to the print 
head module. 

2. Make sure that the capping plate is fitted 
squarely and cleanly. 

3. Make sure that the ventilation screws on 
the underside of the capping plate is 
closed. 

4. Separate the meniscus line of the ink 
tanks and seal them with the delivered 
fittings. 
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4  Replacing the print head module Rho P10 200/250 

 

4.4 Fitting the new print head 
4.4.1 Preparing the new print head 

1. Remove the transport protection from the new print head module. 
2. Cut the ink tubes to an appropriate length. 
3. Identify the ink tubes and print head module with stickers taken from the old print head 

module. 
 

 

4. Refer to the circuit diagram or the old 
print head module for the DIP switch 
settings. 

5. Set the DIP switch on the new print head 
module to those settings.  

 
 

4.4.2 Fitting the print head module 

 

4.5 Commissioning the print head module 
4.5.1 Empty the print head module 

1. Select the Pumps / Valves tab. 
2. Switch off the Ink Level Control. 
3. Select the Printer tab. 
4. Switch on the ink heating. 
5. Select the Ink Heating tab. 
6. Check the temperature of the print heads. 

Wait until the print heads are up to working temperature and until the working temperature 
is stable. 

7. Select the Motors tab. 
8. Set the HMD to 10 mm. 
9. Pull out the light trap. 
10. Move the print carriage until the new print head module is above the purge tray. 
 

 

The meniscus tubes for several print head modules are suspended from one meniscus 
valve. Except where print head modules are to be drained, all meniscus tubes suspended 
from the same meniscus valve must be sealed or clamped. 

1
O N

2 3 4

 

1. Carefully insert the print head module 
into the printing plate and push it into the 
installation position. 
The print head module will perceptibly 
click into place. 

2. Move the print head module to the 
extreme top left corner. 

3. Tighten the fixing screws 
4. Slacken all the fixing screws a few turns. 
5. Connect all cables to the print head. 
6. Connect the ink tubes. 
7. Connect the meniscus tube. 
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Rho P10 200/250 4  Replacing the print head module 

 

 

11. Select the Pumps / Valves tab. 
12. Open the relevant meniscus valve. 
13. Open the purge valve (Purge Ambient Valve). 

Ink is driven out of the print head module under pressure, and flows via the purge tray into 
the collection container. 

14. Wait at least 5 min until the print head module is completely drained. 
15. Close the purge valve. 
16. Close the meniscus valve. 
17. Connect the sealed or clamped meniscus tubes again. 
 

4.5.2 Calculating the LOIS offset (Low On Ink Sensor) 
 The print head module must be drained  
 The DurstPrinter.setup file must be closed 
 The Ink Level Control is switched off 
 The print heads must be up to working temperature (±0,1 °C) 
 

1. Select the LOIS > LOIS Offsets tab. 
2. Press the Edit button. 
 

 

As a rule, the LOIS offset is set individually for each print head module. 
If the LOIS offset is to be calculated for all print head modules (for instance when 
commissioning a new printer), the values can be calculated in a single operation by pressing 
the Initialize Values button. 

 

 

Abb. 4: Overview LOIS offset calculation 

1 Save changes to the DurstPrinter.setup file 
2 Cancel 
3 Load values from the DurstPrinter.setup file 
4 Calculate LOIS offset for all ink tanks 
5 LOIS offset will be calculated as soon as the working temperature is reached 
6 Calculate LOIS offset of a single ink tank 

 

3. In the Setup matrix for the print head module (ink tank), identify the 
– Head#/...: Row in which the print head module is fitted 
– Head#/1: Tank 1 in the print head module (left hand color) 
– Head#/2: Tank 2 in the print head module (right hand color) 
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4  Replacing the print head module Rho P10 200/250 

 

 

 

Example 
Print head required: CK1 
Cyan in CK1: Row "Cyan”, column "Head1/1” 
Black in CK1: Row "Black”, column "Head1/2” 

 

 

4. Right click in the respective field. 
The Initialize Value button appears. 

5. Press the Initialize Value button. 
The LOIS offset for the ink tank will be 
calculated. 

6. Press the Save button. 
The LOIS offset is saved in the file 
DurstPrinter.Setup. 

 

7. Repeat the procedure for the second ink tank in the print head module. 
8. Press the Send to Rho button. 
9. Press the Read From Rho button. 
10. Check that the values in the Printer and Setup areas match. 
11. Select the Pumps / Valves tab. 
12. Switch on the Ink Level Control. 

The print heads are filled with ink. 
 

4.5.3 Close the print head module commissioning 
 Medium is loaded 
 All print heads are operational 
 

1. Select the Purge tab. 
2. Perform 2 long purges with the exchanged print head module (without cleaning the nozzle 

plate). 
3. Perform a long purge with all colors (with cleaning the nozzle plate). 
4. Print a few images to check that all the nozzles are operational. 
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Rho P10 200/250 5  Mechanically aligning the print heads 

 

5 Mechanically aligning the print heads 
5.1 Instructions for working with test patterns 

 Before printing test patterns, print for some time in normal mode. 
 Make sure that the printer is warmed up properly. 
 Make sure that all the nozzles are printing. 
 Select a HMD of 2 mm. 
 

 

In order to ensure good quality, the HMD for the test patterns must be 2 mm.  

 
 Print all the test patterns on paper.  
 

 

Recommended paper: 
Blueback paper, white, 115–150 g/m² 

 

 

1024 pixels are equivalent to the length of a slot (65 mm). 

 

 

The dimensions and proportions of the test patterns shown in this service document differ 
from the test patterns used in practice. The illustrations serve only to give an idea of the test 
patterns and their evaluation. 
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5  Mechanically aligning the print heads Rho P10 200/250 

 

5.2 Adjusting the rotation of the print head modules 
 

 

All the print head modules can be aligned in a single operation. 
Alignment of the print head modules to each another is not necessary in this operation. 

 

Printing the test pattern 
1. Select the Test pattern tab. 
2. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K, c, m, B, O 

Print Quality Mode Test pattern 

Test pattern X-Rotation 

Heads Select all print head modules 

Options High Resolution 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 4: Test pattern X rotation settings 

3. Press the Expose button. 
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Rho P10 200/250 5  Mechanically aligning the print heads 

 

Evaluating the test pattern 

 

Fig. 5: Evaluating the test pattern X rotation (example) 

 

Example 
In the CK1 area the test pattern shows a slight counterclockwise twist. The print head module 
must be twisted in the opposite direction. 
 

Optimum setting 
The area where the upper and lower parts of the print head print above each other must 
display a symmetrical pattern. 
 

Aligning the print head module 
 Have the necessary tools to hand: 

– Head locking wrench for print head module 
– Head adjustment wrench for print head module 

 

 

Method of operation of the adjustment screw (X rotation) 
Clockwise rotation moves the print head module away from the adjustment screw. 
Counterclockwise rotation moves the print head module towards the adjustment screw, but 
not automatically. The print head module must be pushed carefully by hand in this direction. 

 

1. Align the print head module with the adjustment screws for X rotation (do steps of ¼ to ½ 
of a turn). 

2. Print the test pattern and evaluate it. 
3. Repeat the procedure if necessary until the print head module is correctly aligned. 
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5  Mechanically aligning the print heads Rho P10 200/250 

 

5.3 Aligning the CK print head modules in the Y direction 
 

 

The CK print head modules are the reference for all the other colors. Therefore the first step 
is to align these to each other row by row. 
 Perform these operations with the utmost care. 
 First align print head module CK2 to CK1. 
 Repeat the procedure for all other CK print head modules (CK3 to CK2, CK4 to CK3,...). 

 

 The rotation of all print heads is adjusted. 
 

Printing the test pattern 
1. Select the Test pattern tab. 
2. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K 

Print Quality Mode Test pattern 

Test pattern Y Distance 

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Advance before Print 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Paper Advance 512 

Number of advance 1 

Tab. 5: Y Distance test pattern settings 

3. Press the Expose button. 
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Rho P10 200/250 5  Mechanically aligning the print heads 

 

Evaluating the test pattern 

Fig. 6: Evaluating the Y distance test pattern (example) 

Example 
The black lines in the adjustment range are slightly high compared to the reference area. The 
print head module CK2 must be moved down. 
 

Optimum setting 
The arrangement of the lines in the adjustment range match the arrangement of the lines in 
the reference area. 
A check with the naked eye indicates that both areas display a uniform appearance (color, 
brightness, ...). 
 

Aligning the print head module 

 

Method of operation of the adjustment screw (Y direction) 
Clockwise rotation moves the print head module away from the adjustment screw. 
Counterclockwise rotation moves the print head module towards the adjustment screw, but 
not automatically. The print head module must be pushed carefully by hand in this direction. 

 

1. Align the print head module with the adjustment screw for the Y direction (do steps of ⅛ to 
¼ of a turn). 

2. Print the test pattern and evaluate it. 
3. Repeat the procedure if necessary until the print head is correctly aligned. 

2015 ©  Durst Phototechnik DIT GmbH, Print head 10D, Edition 05.03.2015 21 



5  Mechanically aligning the print heads Rho P10 200/250 

 

 

5.4 Aligning KC to CK print head modules 

 

All KC print head modules can be aligned in a single operation. 

 

 The CK print head modules are adjusted in the Y direction. 
 

Printing the test pattern 
1. Select the Test pattern tab. 
2. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K 

Print Quality Mode Test pattern 

Test pattern Y Align 

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 6: Y Align test pattern settings 

3. Press the Expose button. 
 

Evaluating the test pattern 

Fig. 7: Evaluating the Y Align test pattern 

  
 

Fig. 8: Evaluating the Y Align test pattern (example) 
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Example 
The short cyan-colored lines (KC-C) and the long black lines (KC-K) are slightly high 
compared to the reference CK-C and CK-K. 
The print head module KC must be moved down. 
 

Optimum setting 
The short lines are centred exactly between the long lines. 
The CK/KC pattern and the KC/CK pattern both begin with a long line and end with a short 
line. 
 

Aligning the print head module 
( Chapter 5.3, p. 20) 
 

5.5 Aligning MY, YM, cm, mc, OB, BO to CK/KC print head 
modules 
Printing the test pattern 
1. Select the Test pattern tab. 
2. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K, c, m, B, O 

Print Quality Mode Test pattern 

Test pattern Y Align 

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 7: Y Align test pattern settings 

3. Press the Expose button. 
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5  Mechanically aligning the print heads Rho P10 200/250 

 

Evaluating the test pattern 
 

  
 

Fig. 9: Evaluating the Y Align, mc/cm test pattern (example) 

  
 

Fig. 10: Evaluating the Y Align, OB/BO test pattern (example) 

 

 

Fig. 11: Evaluating the Y Align, YM/MY test pattern (example) 

 

Example YM/MY 
In the left 2 pattern the reference of MY and YM is visible. The right 2 pattern show the 
reference of YM/CK and KC/MY. 
It is visible in the 2 left pattern that the height of MY and YM does not fit, but it is not visible, if 
MY must be moved up or YM down. For this reason the pattern YM/CK and KC/MY need to 
be checked. 
In the 2 right pattern it is visible that MY is correct and YM is too high. 
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Rho P10 200/250 5  Mechanically aligning the print heads 

 

 

Optimum setting 
The short lines are exactly centered between the long lines (see the second row of the 
YM/MY test pattern). 
 

 

The YM-CK pattern begins with a short line and ends with a long line. 
The patterns for all the other print head modules begin with a long line and end with a short 
line. 

 

Aligning the print head module 
( Chapter 5.3, p. 20) 
 

5.6 Checking Y distance of MY, YM and KC print head modules 
 

 

After all print heads have been aligned to the reference (CK and KC print head modules; 
 Chapter Fehler! Verweisquelle konnte nicht gefunden werden., p. Fehler! Textmarke 
nicht definiert.), the distance of the print head modules KC, YM and MY in Y direction has 
to be checked. 

 

1. Select the Test pattern tab. 
2. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K 

Print Quality Mode Test pattern 

Test pattern Y Distance 

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Advance before Print 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Paper Advance 512 

Number of advance 1 

Tab. 8: Y Distance test pattern settings 

3. Press the Expose button. 
4. Check the test pattern. 
5. Repeat the procedure if necessary until the print heads are correctly aligned. 
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5.7 Adjusting the rotation of the white print head modules 
Printing the test pattern 
 

 

Test patterns in white or varnish cannot be seen on white paper. 
 Print white test patterns on transparent material. 
 When printing on white paper: Mark the test patterns in white or varnish with orange or 

pink text markers. 
 

1. Purge the white print head modules and print at least 1 m² before printing the test pattern. 
2. Select the Test pattern tab. 
3. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, U, O 

Print Quality Mode Test pattern 

Test pattern X Rotation Spot  

Heads All  

Options High Resolution 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 9: Test pattern X rotation spot settings 

4. Press the Expose button. 
 

Evaluating the test pattern 

 

Fig. 12: Evaluating the X rotation spot test pattern (example) 

 

 For the further procedure see "Evaluating the test pattern” and "Aligning the print head 
module” ( Chapter 5.2, p. 18). 
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5.8 Aligning the white print head modules (F5/F6) in the Y 
direction 
 

 

The CK print head modules are the reference for all the other colors. 
 First align the print head module F5/1 to CK-C. 
 Align the print head module F5/2 to F5/1. 
 Perform the procedure for all further spot print head modules. 

 

Printing the test pattern 

 

Test patterns in white or varnish cannot be seen on white paper. 
 Print white test patterns on transparent material. 
 When printing on white paper: Mark the test patterns in white or varnish with orange or 

pink text markers. 
 

1. Purge the white print head modules and print at least 1 m² before printing the test pattern. 
2. Select the Test pattern tab. 
3. Check and if necessary adjust the following settings: 
 

Area Settings 

Colors and slots C, U, O 

Print Quality Mode Test pattern 

Test pattern Y Align Spot  

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 10: Y Align spot test pattern settings 

4. Press the Expose button. 
 

Evaluating the test pattern 

  
 

Fig. 13: Evaluating the Y Align spot test pattern (example) 

 

 For the further procedure see "Evaluating the test pattern” and "Aligning the print head 
module” ( Chapter Fehler! Verweisquelle konnte nicht gefunden werden., 
p. Fehler! Textmarke nicht definiert.). 
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5.9 Fixing the print head modules in place 
 The print heads must have been mechanically aligned ( Chapter 5, p. 17)  
 

1. Tighten the fixing screws on all print head modules. 
2. Check the Y Distance and the Y Align test pattern again to make sure that the print head 

modules did not get out of place. 
3. Readjust a print head module if necessary. 
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6 Software adjustment 
6.1 Encoder-Offset 

 The print heads must have been mechanically aligned ( Chapter 5, p. 17) 
 

Printing the test pattern 
1. Select the Media area. 
2. Select appropriate type of media.  
3. In the Default Job Options for Media – Print Options  tab select the following settings: 
 

Area Settings 

Print Direction Bi-directional 

Print Finishing Matt 

Print Quality enhancement Deactivate all 

Special Effects Deactivate all 

Print Quality Mode 4 Pass 

Tab. 11: Encoder offset test pattern settings 

4. Select the Printer area. 
5. Select the Printer tab. 
6. In the Encoder Test area, press the Print High Resolution button. 
7. Print the test pattern 
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Evaluating the test pattern 
 

 

Fig. 14: Evaluating the encoder test image 

Example A 
The print shows double lines in a horizontal direction and overlapping between the color 
fields. 
The value for the encoder offset must be increased. 
 

Example B 
The print shows double lines in a horizontal direction and spaces between the color fields. 
The value for the encoder offset must be reduced. 
 

Optimum setting (example C) 
No transition can be seen between the fields. The lines lie more or less on top of each other. 
 

Entering the encoder offset 

 

To achieve visible changes to the test pattern, the value for the encoder offset must be 
changed in steps >10. 

 

1. Select the Setup area. 
2. Select the General tab. 
3. Change the value in the Encoder Offset field. 
4. Print the test pattern and evaluate it. 
5. If necessary change the value for the encoder offset again. 
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6.2 Density compensation 
Printing the test pattern 
 The encoder offset has been adjusted 
 

1. Select the Printer area. 
2. Select the Test pattern tab. 
3. Via From Image File > Select File select the test pattern "VoltageMatch1000.tif". 
4. Select the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K, c, m, B, O 

Print Quality Mode 2 Pass 

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Encoder Control 
DFT Compensation 
Check PH Temp. 
Check UV Lamps 

Paper Advance 1 

Number of advance 8 

Tab. 12: Density compensation test pattern settings 

5. Press the Expose button. 
Evaluating the test pattern 

 

Fig. 15: Evaluating the density compensation test pattern (example) 
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The density within a slot length is not always constant and cannot be influenced by the 
density compensation. This effect is normal. 

Example 
Before the density compensation, the test pattern density shows differences between the 
individual slots of a color. After the density compensation, all differences have been balanced 
out. 
 

Correct setting 
The density in the fields for each color (e.g. cyan) is uniform throughout. 
 

Inputting the values for density compensation 

Parameter Parameter variables Description 

RhoHeadAABSCVoltage AA = color group, e. g. CK 
B = number of the print head 
module 
C = slot number 
Example: 
RhoHeadCK1S1Voltage 

Unit: Volt 
Recommended adjustment 
range: 70 to 82 
Higher values lead to an 
earlier firing impulse and lead 
to larger droplets. 

Tab. 13: Density compensation parameters 

1. Change the values for RhoHeadAABSCVoltage in the DurstPrinter.setup file as 
indicated by the test result. 

2. Save the DurstPrinter.setup file. 
3. Select the Other tab. 
4. Press the Reload and Set button. 
5. Print the test pattern and evaluate it. 
6. If necessary change the values in the DurstPrinter.setup file once again. 
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6.3 Setting the slot offsets using a camera 
 

 

Automatic setting of the slot offset using a camera can be performed only for the colors C, 
M, Y, K, c, m, B and O 
For spot colors the slot offset must be set manually ( Chapter 6.4, p. 41). 
For further information see also the video (Help > Service Instructions). 

 

NOTE! An incorrect power supply can damage the camera! 
 Operate the camera only on 24 V DC. 

 

 

The camera unit is optimally configured for automatic setting of the slot offset. If changes 
are made to the camera unit this will lead to incorrect settings. 
 Never manually change the setting of the optics (e. g. the lenses). 
 Never switch to auto-focus (AF). 
 Never disassemble and reassemble the camera unit. 

 

 

The Canon as well as the Nikon camera system is working with the print heads used in the 
P10 200 and P10 250. 

 

 Have the necessary tools to hand: 
– Canon or Nikon camera system. 

 Have the necessary materials to hand: 
– Digital printing film (3M™ Scotchcal™ Graphic Film Series ij40-10) 

 The print heads must have been mechanically aligned ( Chapter 5, p. 17) 
 The density compensation must have been performed ( Chapter 6.1, p. 29) 
 The drop fly time compensation must have been performed (necessary only when 

commissioning a new printer,  Chapter 6.7, p. 52) 
 Printer software version 1.1 Rev 20 or higher 
 

Preparing for setting 
 

 

Before setting the slot offset, allow the printer to run at least 30 minutes in normal mode. 
 For “warming up” the printer, select an image which contains all the colors apart from 

white 
 

1. Select the Input Queue > Job Options area. 
2. Select the following settings: 
 

Area Settings 

Print Quality HQ 4 Pass 

Print Direction Bidirectional 

Print Finishing Matt 

Special Effect Backlit CMYKcmBO 

Width Full width 

Tab. 14: Settings for warm-up mode 

3. Print for at least 30 minutes 
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Printing a calibration image 
1. Select the Media > Media Definition area. 
2. Select or create the appropriate type of media (3M™ Scotchcal™ Graphic Film Series 

ij4010). 
3. Select the following settings: 
 

Field Settings 

Head Media Distance 2.0 mm 

UV Power +4 

Vacuum 5 

Tab. 15: Settings for the calibration image 

4. Select the Printer area. 
5. Select the Printer tab. 
6. Print several encoder test patterns with the “High Resolution” print setting. 

– In the Encoder-Test area, press the Print High Resolution button. 
7. Select the Test pattern > Printer Calibration tab. Do not change the pre-settings. 
8. Press the Expose button. 
 

 

Fig. 16: Printer calibration test patter for calibration software version 3.x. 
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6.3.1 Nikon camera system 
Preparing the camera system for software version 3.x 

 

Fig. 17: Connection of Nikon camera to the Workstation 

1 Connection cable (camera – transmitter) 
2 Network cable 
3 Ethernet switch 
4 Network port ETH1 on workstation 
5 USB dongle 

6 Switch for main power supply 
7 Start button for transmitter 
8 Status LED’s of transmitter 
9 Main switch of camera 

 
1. Place the camera on a flat, non-slip surface. 
2. Make sure that the DurstPrinter.setup file is closed. 
3. Connect the camera with the transmitter. 
4. Use a network cable and connect the camera directly to network port ETH1 on the 

workstation or use the ethernet switch. 
5. Connect the USB dongle to the workstation. 
6. Connect the power supply to the camera. 
7. Switch on the main power supply of the system. 
8. Push the button start transmitter (7) until the status LED (8) turns green. 
9. Turn on the camera. 
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Camera settings for software version 3.x 
1. Press the Menu button on the camera 

 

2. Select Setup Menu – Network. 
 

 

3. Select Network settings. 
 

 

4. Select FTP_10.0.0.200 
5. Edit the profile with the button “loupe –“. 

 

6. Select FTP. 
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7. Check the port settings: 
Port: 54321 

 

8. Go back to the Network menu and 
select Options. 

 

9. Make sure that Auto send is ON. 

 

 

The required network setting depends on the version of the camera calibration software. 
 FTP_10.0.0.200 - for calibration software version 3.x. 
 PTP_DHCP - for calibration software version 4.x. 
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6.3.2 Canon camera system 
Preparing the camera 
 

 

Fig. 18: Connection of Canon camera to the Workstation 

1 Network cable 
2 Ethernet switch 
3 Network port ETH1 on workstation 
4 USB dongle 

5 Main switch of system 
6 Main switch of transmitter 
7 Main switch of camera 

 

1. Place the camera on a flat, non-slip surface. 
2. Make sure that the DurstPrinter.setup file is closed. 
3. Use a network cable and connect the camera directly to network port ETH1 on the 

workstation or use the ethernet switch. 
4. Connect the USB dongle to the workstation. 
5. Connect the power supply to the camera. 
6. Switch on the main switch of the system. 
7. Turn on the transmitter. 
8. Turn on the camera. 
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6.3.3 Creating photos with software version 3.x 
1. Select the Printer Calibration tab. 
2. Press the X-Align button. 

The camera software must be started. 

 

Abb. 19: Overview camera software 

1 Progress of the calculation of the pictures 
Yellow: not calculated 
Green: Calculation OK 
Red: Calculation failed 

2 Status 
3 Detailed view of the results of the calculation (Offset and angle of the slots) 
4 Version of the Printer Calibration Software 

 

3. In the Camera Link area, press the LAN button. 
4. Select Write DurstPrinter.setup and Clean Images after Calibration. 
5. Press the Start button. 
6. Switch on the camera. 
7. Select the camera program C1. 
 

 

A camera is shown on the Printer Calibration image; this indicates the direction in which the 
camera must point when taking pictures. 
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8. Take the photos in the following 
sequence: 
CMYK: 1, 2, 3, … 
Other: 1, 2, 3, … 

9. Wait until the photos have been loaded 
to the workstation and all the displays of 
photos in the printer software are green. 

 

 

If the photos are not loaded correctly, check that the camera is connected by LAN to ETH1. 

 

10. If the display of a photo turns red, take the photo again. Make sure you perform the 
actions in the specified sequence. 

11. The calibration was successful if Calibration DONE and Setup File Written turn green. 
12. To exit the printer calibration software, press the Abort / Exit button. 
 

 

The photos can be loaded to the workstation by LAN or manually. For loading manually, 
proceed as follows: 
 In the Camera Link area, press the Manual button. 
 Copy the photos (file format *.CR2) from the camera into the directory 

/mnt/images/calibration on the workstation. 
 

6.3.4 Repeat the setting 
 

 

For fine adjustment of the slot offset, perform the setting a second time. 

 

1. Before performing the setting the again, allow the printer to run at least 15 minutes in 
normal mode. 

2. Print the calibration image. 
3. Create the photos. 
 

6.3.5 Troubleshooting 
The calibration software will create a backup of the DurstPrinter.setup file with a time stamp in 
the folder /usr/local/printsw. 
 
Every time when a calibration is started the software will create a folder with the current time 
stamp in /mnt/images/calibration/debug. 
In case of problems it’s necessary to upload the respective folder with the time stamp to our 
FTP server and to contact Durst Service. 
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6.4 Setting the slot offsets manually 
6.4.1 Setting the slot offset within a color 

 

 

The slot offset can be set for all print head modules in a single operation. 
Alignment of the print head modules to each another is not necessary in this operation. 

 

Printing the test pattern 
1. Select the Test pattern tab. 
2. Select the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K, c, m, B, O 

Print Quality Mode Test pattern 

Test pattern Slot Offset 

Heads All  

Options High Resolution 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Paper Advance 0 

Number of advance 1 

Tab. 16: (Manually) setting the slot offset test pattern 

3. Press the Expose button. 
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Evaluating the test pattern 
 

 

Fig. 20: Evaluating the slot offset test pattern 

 

Example 
The part lines of the KC1 print head module lie too far to the right, compared to the part lines 
of the CK1 print head module. The slot offset values for KC1S2L and KC1S2R must be 
reduced; note that the values for KC1S2R must be reduced more than the value for KC1S2L. 
 

Optimum setting 
The two lines lie about 1.2 mm to 1.4 mm apart. 
Note: The distance x between the two lines must be the same for all head rows! 
The part lines created by the CK and KC print head modules generate a continuous line over 
the length of the print head. 
 

Setting the values for the slot offset 
 

Parameter Parameter variables Description 

RhoSlotOffsetAABSCD AA = color group, e. g. CK 
B = number of the print head 
module 
C = slot number 
D = direction (L/R) 
Example: 
RhoSlotOffsetCK1S1L 

Unit: Pixel 
Default setting: 0 
Increasing the value moves 
the line to the right (as seen 
from the material output 
side). 
Reducing the value moves 
the line to the left. 

Tab. 17: Parameter Slot-Offset 
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1. Change the values for RhoSlotOffsetAABSCD in the DurstPrinter.setup file as 
indicated by the test result. 

2. Save the DurstPrinter.setup file. 
3. Press the Reload setup entries button. 
4. Print the test pattern and evaluate it. 
5. If necessary change the values in the DurstPrinter.setup file once again. 
 

6.4.2 Setting the slot offset between all other colors and black 

 

The slot offset can be set for all print head modules in a single operation. 
Alignment of the print head modules to each another is not relevant to this operation. 

 

Printing the test pattern 
( Chapter 6.4.1, p. 41) 
 

Evaluating the test pattern 
 

 

Fig. 21: Evaluating the slot offset test pattern 

Example 
The cyan part lines lie too far to the left, compared to the black part lines. The slot offset 
values for CK1S1L, KC1S2L CK1S1R and KC1S2R must be increased. 
 

Optimum setting 
The two lines lie about 1.2 mm to 1.4 mm apart. 
The part lines created by the black slots and the color slots generate a continuous line over 
the length of the print head. 
 

Setting the values for the slot offset 
( Chapter 6.4.1, p. 41) 
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6.4.3 Setting the slot offset between the rows 
 

 

The slot offset can be set for all print head modules in a single operation. 

 

Printing the test pattern 
1. Select the Test pattern tab. 
2. Select the following settings: 
 

Area Settings 

Colors and slots C, M, Y, K, c, m, B, O 

Print Quality Mode Test pattern 

Test pattern X Head Row Offset 

Heads All  

Options High Resolution 
Unidirectional 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 18: X Head Row Offset test pattern settings 

3. Press the Expose button. 
 

Evaluating the test pattern 
 

 

Fig. 22: Evaluating the X Head Row Offset test pattern 
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Example 
The lines for the print head rows 1 and 2 lie too far to the left, compared to the lines for the 
print head row 4. The slot offset values for print head rows 1 and 2 must be increased; note 
that the value for print head row 2 must be increased more than the value for print head row 1. 
 

Optimum setting 
The lines for the print head rows must generate a continuous line. 
 

Setting the values for the slot offset 

Parameter Parameter variables Description 

RhoSlotOffsetRowF F = print head row Unit: Pixel 
Default setting: 0 
Increasing the value moves 
the line to the right (as seen 
from the material output 
side). 
Reducing the value moves 
the line to the left. 

Tab. 19: Parameter X Head Row Offset 

1. Change the values for RhoSlotOffsetF in the DurstPrinter.setup file as indicated by 
the test result. 

2. Save the DurstPrinter.setup file. 
3. Press the Reload setup entries button. 
4. Print the test pattern and evaluate it. 
5. If necessary change the values in the DurstPrinter.setup file once again. 
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6.5 Setting the slot offset for white print head modules (for 
printers with 4 CMYK print head rows) 

 

For printers with 4 CMYK print head rows the slot offset can be set for all white print head 
modules (F5/1, F5/2 and F6/1, F6/2) in a single operation, since the spot colors can be set 
to the black reference. 

 

 

Fig. 23: Printer with 4 CMYK print head rows (example) 

 

Printing the test pattern 

 

Test patterns in white or varnish are difficult to be seen on white paper. 
 Print white test patterns on transparent material. 
 When printing on white paper: Mark the test patterns in white or varnish with orange or 

pink text markers. 
 

1. Purge the white print head modules and print a least 1m² before printing the test pattern. 
2. Select the Test pattern tab. 
3. Via From Image File > Select File select the test pattern "Slot Offset (Spot)". 
4. Select the following settings: 
 

Area Settings 

Colors and slots K, U, O 

Print Quality Mode Test pattern 

Heads All  

Options High Resolution 
Encoder comp. 
Encoder Control 
Check PH Temp. 
Check UV Lamps 

Tab. 20: Slot Offset (Spot) test pattern settings 

5. Press the Expose button. 
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Evaluating the test pattern 
 

 

Fig. 24: Evaluating the slot offset (spot) test pattern 

 

Example 
The part lines for the F5/1 print head module lie too far to the left, compared to the black part 
lines. The slot offset values for F5/1S1L, F5/1S2L, F5/1S1R and F5/1S2R must be increased 
accordingly. 
 

Optimum setting 
The part lines created by the black slots and the spot color slots generate a continuous line 
over the length of the print head. 
 

Setting the values for the slot offset 
( Chapter 6.4.1, p. 41) 
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6.6 Setting the slot offsets for white print head modules (for 
printers with 2 CMYK print head rows) 
 

 

For printers with 2 CMYK print head rows the slot offset must be set for all print head 
modules in 3 steps, since there is no reference print head module in the same row. 
The procedure below is described for print head module F5/1, but it can be adapted for the 
other white print head modules (F5/2, F6/1, F6/2). 

 

 

Fig. 25: Printer with 2 CMYK print head rows (example) 

 

6.6.1 Setting the slot offsets to line up the pattern for the left and the right printing direction 
Printing the test pattern 
( Chapter 6.5, p. 46) 
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Evaluating the test pattern 
 

 

Fig. 26: Evaluating the slot offset (spot) test pattern 

A Setting the slot offsets to line up the pattern for the left and the right printing direction 
B Adjusting the slot offsets to adapt the drop fly time of black 
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The test pattern is printed bidirectional. Therefore the slot offset of each slot must be 
adjusted for the left and the right side. 

Example A 
The part lines of slot 1 and slot 2 of the print head module do not generate a continuous line 
for the left and the right printing direction.  
The slot offset values for F5/1 S1L, F5/1 S2L and F5/1 S1R, F5/1 S2R must be changed. 
 

Optimum setting 
The part lines of slot 1 and slot 2 of the print head module generate a continuous line for the 
left and the right printing direction. 
 

Setting the values for the slot offset 
( Chapter 6.4.1, p. 41) 
 

6.6.2 Setting the slot offsets to adjust the distance between the left and the right line. 
Printing the test pattern 
( Chapter 6.5, p. 46) 
Evaluating the test pattern 
( Chapter 6.6.1, p. 48) 
 
 Measure the distance x (drop fly time) between the left and the right black line. 
 

Setting the values for the slot offset 
 Set the values for the slot offsets of the white print head modules so that the distance y 

between the left and the right white line is equal to the distance x ( Chapter 6.4.1, 
p. 41). 

 

 

To move a line, two parameters must be set, e. g.: 
 RhoSlotOffsetF5_1S1L = +5 
 RhoSlotOffsetF5_1S2L = +5 

 

6.6.3 Setting the slot offset between white and black 
1. Disconnect the connection for the firing impulse of the print head module F5/2. 
 

 

The line for white under will be printed only with F5/1. 

 

2. Select the Media area.  
3. Select appropriate type of media.  
4. In the Default Job Options for Media – Print Options tab select the following settings:  
 

Area Settings 

Print Direction Bi-directional 

Print Finishing Matt 

Print Quality enhancement Deactivate all 

Special Effects Deactivate all 

Print Quality Mode 4 Pass 

Tab. 21: Slot Offset (white to black) test pattern settings 
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5. Select the Printer area. 
6. Select the Printer tab. 
7. In the Encoder-Test area, press the Spot Inks button. 
 

 

Fig. 27: Evaluating the Encoder Test test pattern 

8. Determine the offset between the line printed by F5/1 and the reference black. 
9. Set the value for the slot offsets of the print head module F5/1 so that the white and 

reference black are in line ( Chapter 6.4.1, p. 41). 
 

 

To move a line, four parameters must be set, e. g.: 
 RhoSlotOffsetF5_1S1L = -6 
 RhoSlotOffsetF5_1S1R = -6 
 RhoSlotOffsetF5_1S2L = -6 
 RhoSlotOffsetF5_1S2R = -6 

 

10. Reconnect the connection for the firing impulse of the print head module F5/2. 
11. Disconnect the connection for the firing impulse of the print head module F5/1. 
12. Perform steps 2 to 5 for print head modules F5/2, F6/1 and F6/2. 
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6.7 Drop fly time compensation 
 The head media distance must be correctly set ( service manual settings) 
 

Printing the test pattern 
 

 

Each HMD value and each resolution saved in the DurstPrinter.setup file needs to have its 
own offset. 

 

1. Make an archive copy of the DurstPrinter.setup file. 
2. Set the values for RhoDFTCDataDistancex for each head media distance in the file 

DurstPrinter.setup to 0. 
3. Select the Media tab. 
4. Set the HMD to the desired value (e. g. 2 mm) and load the medium. 
5. Select the Printer tab. 
6. In the Encoder-Test area, select the High Resolution or Vario Drop resp. High Speed 

button: 
– High Resolution (printing at 1000x800 dpi) 
– High Speed (printing at 800x600 dpi) 
– Vario Drop (printing at 600x600 dpi) 

 

 

Depending on the printer configuration either the resolution High Speed or the resolution 
Vario Drop (default) is available. 

 

Evaluating the test pattern 
 

 

Fig. 28: Evaluating the test pattern  

 Measure the distance d on all test patterns. 
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Optimum setting 
The vertical lines generate a single line. The text is sharp. 
 

 

Depending on resolution and head media distance the text and the vertical lines will not 
always show the same result! 
 Use the text for fine tuning. 

 
Inputting the values for drop fly time compensation 

Parameter Parameter variables Description 

RhoDFTCDataHMD 0.150  0.200  0.300  0,400 Unit: cm 
Adjustment range: 0.150 to 0.500 
HMD values for the drop fly time 
calculation 
Each value is delimited by a space. 

RhoDFTCDataDistancex x = resolution 
x=1000  High Resolution 
x=800  High Speed 
x=600  Vario Drop 

Unit: cm 
Measured distance between the lines 
as a function of the head media 
distance, 
e.g. -0.140  -0.160  -0.220  -0.250 
Each value is delimited by a space. 

Tab. 22: Drop fly time compensation parameters 

1. Change the values for RhoDFTCDataDistancex in the DurstPrinter.setup file 
according to the results of the evaluation. 

2. Save the DurstPrinter.setup file. 
3. Press the Reload setup entries button. 
4. Print the test pattern and evaluate it. 
5. If necessary change the values in the DurstPrinter.setup file once again. 
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6  Software adjustment Rho P10 200/250 

 

6.8 Slot border compensation 

 

The density at the edges of the slot is adjusted via the slot border compensation. 

 

 The encoder offset has been adjusted 
 

Printing the test pattern 
1. Select the Input Queue area. 
2. Select an image that satisfies the following requirements (example:  Fig. 29, p. 54): 

– Solid surface 
– Progress over the surface 
– High ink application 

3. Select the following settings: 
 

Area Settings 

Print Direction Bi-directional 

Print Finishing Matt 

Print Quality enhancement Deactivate all 

Special Effects Deactivate all 

Print Quality Mode 2 Pass 

Tab. 23: Slot border compensation test pattern settings 

Evaluating the test pattern 
 

 

Fig. 29: Example of a slot border compensation test pattern 
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Rho P10 200/250 6  Software adjustment 

 

Example 
The printing exhibits darker areas at the transitions from one pass to the next. The density at 
the slot borders must be reduced. 
 

Optimum setting 
The printing exhibits saturated colors at the transitions from one pass to the next. 
 

Inputting the slot border compensation 

 

The settings apply to all colors and all slots. 

 

Parameter Parameter variables Description 

RhoHeadCompensationU 

RhoHeadCompensationL 

U = upper part of the pass 
L = lower part of the pass 

Unit: % 
Recommended adjustment range: 
0 to -10 
A reduction of the value reduces 
the density on the selected length 
in the upper/lower parts of the 
pass 

RhoHeadCompensationLenU 

RhoHeadCompensationLenL 

Unit: cm 
Length over which the density is 
to be adjusted 
Recommended adjustment range: 
0.00 to 0.20 

 

1. Change the values in the DurstPrinter.setup file as indicated by the test result. 
2. Save the DurstPrinter.setup file. 
3. Select the Reload setup entries button. 
4. Print the test pattern and evaluate it. 
5. If necessary change the values in the DurstPrinter.setup file once again. 
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